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Introduction

Introduction

Power Distribution Modules (PDMs) replace conventional relays, fuses and
circuit breakers by providing electronically switched power to the various
electrical systems in the vehicle, including motors, lamps, ECUs and data
systems. This simplifies wiring and switch requirements, while increasing

reliability.

There are four PDM versions: PDM16, PDM32, PDM15 and PDM30.
Throughout this manual all versions will be referred to as the PDM except
where details specific to a particular version are discussed.

Features

PDM16 PDM32 PDM15 PDM30
Inputs 12 23 16 16
8 Amp Outputs 8 24 7 22
20 Amp Outputs 8 8 8 8
Connectors Autosport Waterproof connectors

M6 stud

Case size
Length 130 mm 180 mm 107 mm 107 mm
Width 60 mm 60 mm 133 mm 133 mm
Height 28 mm 28 mm 39 mm 39 mm

e Each output is over-current, short circuit and thermal overload protected.
e Outputs are programmable in 1 A steps

e Outputs are controllable via a combination of switch inputs, CAN
messages and logic functions.

e Switch inputs range from 0 to 51 V with a resolution of 0.2 V.

e Up to 200 logic operations can be performed using operators like Flash,
Pulse, Set/Reset, Hysteresis, Toggle, And, Or, Less than, Greater than,

Not equal to, Equal to, True, False etc.

e Typical functions include flashing indicator lights and control of thermo

fans and fuel pumps.

¢ Logic functions can be used to selectively turn off systems during low
battery voltage or engine starting, reducing drain on the battery.
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Full diagnostic information is provided, including output currents and
voltages, input voltages, and error status.

Diagnostic information can be transmitted via CAN to a display or data
logging device or monitored directly on a PC.

Unauthorised access can be prevented by setting a password.

Accessories

MoTeC UTC (USB to CAN adaptor) #61059
(Note: PDMs are not compatible with MoTeC CAN cable)

System Overview

Lyl

Battery
Battery Input
o >
o » Inpus  PDM cAN
Switches
Outputs
1 L 1 L Other
Motors Lights Devices

CAN bus

>

ECU

L
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Installation

Mounting

When mounting the PDM, consider that the PDM may get very hot during
operation.

Ensure the PDM is mounted in a well ventilated area and not against a hot
surface. For case dimensions see Mounting Dimensions.

The internal temperature is highly dependent on ambient temperature and
also on the total load current - a higher current will cause a higher
temperature.

Tip: The internal temperature can be checked in PDM Manager (see
Operation) or transmitted via CAN to be logged. Allow for sufficient time
for the temperature to stabilise. This may take 30 minutes or more.

If the internal temperature of the PDM exceeds the specified maximum values
(see Specifications), cooling may be achieved by one or more of the following:

¢ Relocating the PDM to a cooler mounting position

¢ Increasing air circulation around the PDM case

¢ Ducting cool air over the PDM case

e Fitting a heatsink to the back surface of the PDM case
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Wiring
)
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Battery Positive
Battery positive is supplied to the PDM via the single pin connector to suit wire
sizes 16 mm2 (6#) or 25 mm? (4#).

The PDM16 and PDM32 use an Autosport connector; PDM15 and PDM30
use a 6 mm eyelet to suit the wire size.

The wire gauge should be chosen according to the wire temperature limit and
acceptable voltage drop. Tefzel wire must not exceed 150 °C.

The temperature of the wire is affected by the ambient temperature, air
circulation, current, wire gauge, the temperature of any surrounding wires and
the covering sheath.

See Wire Specification and Connectors and Pinout for details.

Battery Isolator Switch

Battery positive must generally be connected via an isolator switch or relay.
The isolator must isolate the battery from all devices in the vehicle including
the PDM, starter motor and alternator. The isolator must be rated to handle
the starter motor current.

When the battery is isolated, the engine may continue to run due to power
supplied by the alternator. To avoid this, the isolator switch should have a
secondary switch that is connected to a shutdown input on the ECU.
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If the ECU does not have a shutdown input, the switch can be connected to a
PDM input. The PDM can then turn off power to the ignition system or the
ECU, which will cause the engine to stop.

Battery Negative

Both of the Batt— pins should be wired to battery negative via 20# wire.

These pins normally only carry the very low operating current, however,
during a load dump they carry the load dump current which may be 50
ampere or higher.

CAN Wiring

The PDM communicates over CAN with other devices connected to the same
CAN bus. The CAN bus must be wired according to CAN Bus Wiring
Requirements.

The PC also communicates to the PDM via the CAN bus. See Connecting the
PDM to a PC.

Input Wiring

The PDM Switch Inputs are intended for use with a switch that is directly
wired between a PDM input pin and a PDM 0 V pin. Each input has an
internal 10 kilo-ohm pull-up resistor to Batt+.

If it is required to connect a switch that is wired to another system in the
vehicle, ensure that the voltage levels are set appropriately as there may be
ground voltage variations between devices.

Tip: If standby current is important, wire the switches so that they are
normally open during standby. This will reduce the standby current.

Input Switch Connected to Battery

When an input is driven from a device that switches to battery, the switch
should, if possible, be rearranged so that it switches to 0 V.

If the signal comes from an electronic device, such as an ECU, with an output
that can only switch to battery (e.g. a signal that indicates when to turn the
fuel pump on), this might not be possible. In such cases an external pull-
down resistor is required. The resistor should be 1500 ohm 0.25 watt and
should be connected between the input pin and the 0 V pin.

The input trigger levels should be set to 4 V and 5 V to guarantee correct
triggering for all possible battery voltages.
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Output Wiring

All outputs are high side type outputs; they switch Batt+ to the output pin.
They all have hardware thermal overload protection, fault logic and over-
current logic.

Paralleled Outputs

Two or more output pins can be connected in parallel to increase current
capacity. Outputs that are connected in parallel must all be of the same type;
either all 8 Amp or all 20 Amp.

Wire Gauges

The wire gauge must be chosen to suit the current consumed by the
connected device and to ensure that the voltage drop is acceptable. On long
runs it may be necessary to use a heavier gauge wire to minimise voltage
drop.

The wire gauge must also be compatible with the connector pin; using a
smaller than recommended wire gauge may result in a poor crimp.

Suitable wire gauges are 24# to 20# for the 8 Amp outputs and 20# to 16# for
the 20 Amp outputs. See Wiring for details.

Output Devices

Windscreen Wipers

The PDM can drive windscreen wiper motors. The wiper unit can be wired in
several ways.

Note: Older PDMs (hardware version 1) cannot be connected to both the fast
and slow motor windings at the same time. The voltage generated by the slow
winding during fast operation will cause braking of the motor and possible
damage to the PDM.

The PDM hardware version is indicated by a symbol, e.g. , next to the
engraved serial number on the PDM case.
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The following schematics are shown for ‘common-ground’ wiper units. For
‘common-positive’ wiper units the schematics must be adjusted accordingly.

1. OEM Controller Method

Output ——— >

PDM
OEM
controller

Control — >
Switches ———»|

The wiper unit can be wired using an OEM wiper controller with the PDM
supplying the power only.
The OEM controller performs the intermittent and motor braking functions.

2. Two Switch Method
On

Output

PDM

The wiper unit can be wired in a simple two switch arrangement; one switch
for power and the other to select fast or slow. The PDM supplies power only.
Wiper motor braking is performed by the combination of the park switch and
the on/off switch.

This arrangement cannot perform intermittent operation since the wiper will
not park if the PDM simply removes power.

The switches must be able to handle the wiper motor current (typically

4 ampere).
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3. Relay Method

Relay
Control Output
Switches
—> PDM
E— Output

The two switch method can be modified for intermittent operation by replacing
the on/off switch with a relay. The PDM controls the relay to perform the
intermittent function. This requires two PDM outputs; one to supply power and
the other to control the relay.

Motor braking is performed by the combination of the park switch and the
relay switch.

The PDM must be configured with the appropriate logic to perform on/off and
intermittent operation based on the state of the control switches.

Slow operation can be achieved using the switch or using intermittent
operation to give a similar effect which avoids the need for a high current
switch.

The fast/slow switch and on/off relay must handle the wiper motor current
(typically 4 ampere). The control switches can be low current types since they
only connect to PDM inputs.

4. Direct Method

| Output 9

Control ——»

Switches — 3 PDM
Input

The wiper unit can be wired directly to the PDM as long as it is only connected
to one output.

In this method the park switch is wired directly to a PDM input so the park
logic must be configured in the PDM.

This method requires the use of Output 9 which performs motor braking. The
PDM performs motor braking by momentarily shorting the output to ground
when the output turns off.
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The PDM must be configured with the appropriate logic to perform on/off and
intermittent operation based on the state of the control switches.

Slow operation can be achieved using a switch between the fast and slow
windings as used in the other methods or intermittent operation can be used
to wipe less frequently.

The control switches can be low current types since they only connect to PDM
inputs.

5. Direct Method with Linked Channels — PDM Hardware
Version 2 onwards

PDM hardware, version 2 onwards, has additional functionality to simplify
windscreen wiper motor control.

Note: The PDM hardware version is indicated by a symbol, e.g. , next to
the engraved serial number on the PDM case.

This method requires the use of Output 9 which provides special wiper
functionality:

- Output 9 is isolated whenever the user-nominated linked high speed
wiper output is turned on. This protects Output 9 from the high voltage
generated by slow winding, and also prevents Output 9 from braking
the motor when the high speed winding is turned on. The linked high
speed wiper output can be configured in the Output 9 settings.

- Output 9 performs motor braking by momentarily shorting the output
to ground when the output turns off.

Output 9
COI’]tI‘O| 4’ OUtpUt X

Switches — 3 PDM

Input

, 7 Park

Switch

The PDM must be configured with the appropriate logic to perform on/off,
speed selection, intermittent operation and wiper parking based on the state
of the control switches and park switch input.

The diagram below shows an example sequence of wiper operations. The
wiper slow condition is set up to operate the slow winding when the wiper
switch is on, or when the wiper is not parked. When the linked fast winding
output is on, Output 9 is held off even though the condition driving output 9 is
still true.
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Wiper slow
input

Wiper fast
input

Wiper park —
switch input __l “ |_| |_| |.| |_| |_| I_l |_| I.I “ ” |_|

Wiper slow
condition
Out x (High
Winding)

Out 9 (slow
winding)

< > b
Out 9 held off while Parking
linked output is on

Consider when implementing wiper control logic:

- The condition for the slow winding output (Output 9) can remain true
even when the fast winding output is on.

- The wiper should always be parked from the slow winding output
(Output 9) so that motor braking can be used.

- Set the High Time and Low Time to 0.00s in the park switch input pin
configuration so that the wiper is parked as soon as possible after
reaching the park position.

A sample configuration for this method is included with PDM Manager.

Solenoids

The current drawn by a normal, single coil solenoid ramps up from zero to its
steady state value over a period of time. The time taken to do this depends on
the inductance and resistance of the solenoid but is normally very short (less
than 0.1 second). This has no effect on the PDM.

A solenoid will generate a voltage spike when turned off; this is clamped and
absorbed by the PDM. The amount of energy absorbed by the PDM depends
on the inductance and current in the solenoid. The PDM is capable of
absorbing the energy of most normal solenoids in a vehicle.

Two Stage Solenoids

Some solenoids have two windings; one is used to turn the solenoid on, the
other is used to hold it on once it has switched. This ensures optimum turn on
characteristics with minimum holding current.
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The current drawn by the turn on winding may be higher than the current
drawn by the holding winding. Ensure the Output Load is well clear of 100%
during turn on and during holding.

Starter Solenoids

In many cases it is possible to run starter solenoids from a single 20 Amp
output even though they typically draw more than 20 ampere (possibly as
much as 40 ampere).

The Over-Current Shutdown feature allows excess current for a period of
time. This feature will shut down the output after about 10 to 20 seconds of
cranking. See the Over-Current Shutdown section for details.

The wire can be rated for 20 ampere, also ensuring that the starter motor
does not overheat during excess cranking. A larger wire gauge might be
required if the voltage drop is not acceptable.

Alternatively two 20 Amp outputs may be paralleled allowing cranking for any
period of time (subject to overheating of the starter motor).

Electronic Devices

The PDM can supply power to electronic devices such as engine
management systems, data acquisition systems, radios etc.

Many electronic devices will have a short inrush current. The PDM will largely
ignore this due to the Output Load filtering. See the Over-Current Shutdown
section for details.

The PDM provides reverse battery protection and load dump clamping to
protect itself and the connected devices.

Ignition Systems

Inductive Ignition Systems
Most inductive ignition systems draw a peak current of about 8 ampere.
Some draw as much as 20 ampere but, the average current is much lower.

In most cases, inductive ignition systems can be connected to an 8 Amp
output, however, the Output Load current must be checked to ensure it
stays well clear of 100%.

The average current will increase with increasing RPM so the Output Load
should be checked at maximum RPM.

CDlI Ignition Systems

CDl ignition systems can draw peak currents of as much as 50 ampere. It
is recommended that all CDI ignition systems are connected to a 20 Amp
output.
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The average current will increase with increasing RPM so the Output Load
should be checked at maximum RPM.

Engine Management Systems

The current drawn by an engine management system will depend on the type
of loads it is connected to and the operating conditions.

Fuel injectors draw current in pulses. The maximum average current drawn by
the fuel injectors is when they are at maximum duty cycle.

For servo devices, such as Drive by Wire motors, maximum current is drawn
when making large transitions.

Check that the Output Load is clear of 100% under worst case operating
conditions, i.e. when the injectors are operating at maximum duty cycle, servo
devices are making large transitions and any auxiliary loads are drawing
maximum current.

CAN Keypads

The CAN Keypads continuously communicate with the PDM, preventing the
PDM from entering its low power standby mode.

Options for powering the Keypads include:
- Configuring the PDM to always power the Keypads.

This allows buttons on the Keypads to be used for master startup
functions, but the PDM would never enter standby mode.

To minimise battery drain, the isolator would need to be turned off
(e.g.. during vehicle transport or storage)

- Wiring a master switch or ignition key input to the PDM.

All outputs (including the Keypad power) would be configured to turn
off when the master switch or key is turned off.

This allows the PDM to enter standby mode, minimizing battery drain.
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PDM Manager Software Installation

The PDM Manager software is used to:

Change the PDM configuration

Monitor the PDM operation including the output currents and
diagnostics

Test the outputs by manually turning them off and on
Set and unlock security password
Update the firmware

PC Requirements

Operating system: Windows 7 or later (Windows 8, Windows 10).

Minimum screen resolution: 1366 x 768.
A USB port is required for communication with the PDM.

Installing PDM Manager Software

e Go to the MoTeC website at www.motec.com and navigate to
downloads/software/latestreleases/PDM Manager software

OR Locate PDM Manager software on the MoTeC Resource USB
e Save the selected file in your preferred location (for example desktop)
e When downloading is finished, double click on the file and select Run

¢ Follow the instructions on the InstallShield Wizard

e To start the program after installation, click
Start > All Programs > MoTeC > PDM Manager

Updating PDM Manager Software

Software updates are available to give access to the latest features.

Download the latest software version from the website and follow the software
installation instructions to update to the new version.

To update the associated firmware in the device select Update Firmware from
the Online menu. For more information refer to Operation.

Connecting the PDM to a PC
The PC communicates with the PDM via the CAN bus.
The connection to the CAN bus is via USB through a MoTeC UTC.

To connect through a UTC, a mating connector for the UTC must be wired to
the PDM's CAN bus.


http://www.motec.com/

14 Installation

Refer to UTC Wiring for PC Connection and CAN Bus Wiring Requirements
for more information.

The PC must connect to the PDM at the configured PDM CAN bitrate. Refer
to the Operation section for details about CAN bitrate configuration.

Note: The MoTeC CAN cable (#61021) cannot be used with the PDM.
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Configuration

The PDM requires various settings to be configured, such as the maximum
current settings for the outputs and the circumstances in which to turn the
outputs on.

The configuration settings are stored in a configuration file on the PC.

Changes to the PDM configuration are performed ‘Offline’, i.e. without the PC
communicating with the PDM. The changes are saved in the configuration file
on the PC. The file must be sent to the PDM before the changes take effect.
See Operation.

Configuration File

From the File menu the following options are available:
e New: creates a new configuration file

e Open: selects an existing configuration file
Right-click the configuration file to Rename, Delete, Send to a disk etc.

e Close: closes the current configuration file

e Save: after a new configuration has been defined, it should be saved with
a meaningful name

e Save as: can be used to create a copy of an existing configuration file by
giving it a new name

e Check Channels: verifies that all channels are correctly generated
o EXxit: exits the program

To create a new configuration file

e On the File menu click New
e Select the PDM type and enter the Serial Number
The serial number can be found on the PDM label.
This will open the Configuration Tree panel and the Channels panel.

Tips:
e The most recently used files appear at the bottom of the File menu.
This is often the easiest way to open an existing file.

¢ When changing the PDM type, all configured input and output settings
will be transferred to the relevant pin number in the new PDM type.

e Configuration files can be password protected, preventing unauthorised
retrieval and sending of configuration files.
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Channels

Channels are used to link the various systems within the PDM configuration.

For example: The input pin system generates two channels for each
configured input pin. Depending on the state of the input pin the input channel
value will be zero or one.

The channel can be selected to directly control a particular output. It can also
be used as an input to a Condition. This is a complex logic function that
combines a number of channels to create a new channel. This new channel
can then be used to control an output, or as an input to another condition.

Each channel can only be generated once, but may be used by multiple
outputs and conditions.

Channel Names

Each channel has a name to identify it. By including a dot between parts of
the channel name, channels are arranged in a tree structure.

For example: Indicators.Left and Indicators.Right would appear as Left and
Right under a node called Indicators.

Search:

=& Indicatars
+-000 Left
+-1 Right
= |2 POM
nl
ﬂ CaM Inputs
mol CAM Timeout
ﬂ Corstants
M Global Emor
ﬂ [nput Yoltages
N |nternal A5
Wl Temperature
WA Total Current

-

+

ak ] [ Cancel

The use of a dot between parts of the channel name is optional. The channel
list will be a simple flat list rather than a tree structure if it is not used.
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To rename a channel globally

¢ Right-click on the channel name in the Channels window and click
Rename.
This will rename the channel where it is generated as well as in all the
places where it is used.

Configuration Tree

The Configuration Tree is used to configure the Global Setup, Input Pins,
CAN Inputs, Conditions, CAN Outputs, Keypad buttons and Output Pins.

The input and output pins will be numbered according to the PDM type
selected.

Global Setup

The Global Setup in the configuration tree is used to:
e Enter the PDM type and serial number

e Configure the CAN addresses and timeout periods for incoming CAN
messages

e Configure the condition controlling the transmission of outgoing CAN
messages

e Configure Master Retry and Master Shutdown channels for output pins
e Configure Keypad settings for CAN Keypads

PDM Type and Serial Number

The PDM type (e.g. PDM32, PDM16) and serial number must be configured
correctly before a new configuration file can be sent to a PDM.

A configuration can only be sent to the matching PDM to ensure the correct
configuration of PDMs in applications with multiple PDMs.

CAN Outputs Transmit

CAN Outputs Transmit can be used to control when outgoing PDM messages
are transmitted:

- Always
- Channel: when a selected Channel is true
- Condition: when a user defined Condition is true.

CAN Output transmissions may need to be disabled in order to support the
PDM entering Standby Mode. See also
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Standby Mode

Note: These settings affect all CAN messages transmitted by the PDM (e.g.
those required for CAN Keypad operation), not just standard/user messages.

Output Pins Master Retry

The Master Retry feature turns all outputs that are in error back on. If there is
still a fault on a particular output, this output will go into error again and will go
through the normal retry sequence.

To initiate a Master Retry by pressing a button
e Wire a button to a switch input

¢ Use the channel generated by this input as the trigger channel for the
Master Retry.

Output Pins Master Shutdown

The Master Shutdown feature turns off all outputs that are configured for
Master Shutdown, while a user configured channel is true.

Any PDM channel can be used as the Master Shutdown channel.

Each output pin can be individually configured to support or ignore the Master
Shutdown channel.

Keypads
Up to four MoTeC CAN Keypads can be configured to work with the PDM.

The global Keypad setup configures the overall Keypad settings. Individual
Keypad buttons are configured under the Keypads in the Configuration Tree.

The Keypad Name is a description of the Keypad (e.g. “Main Keypad”).

The Keypad Type determines how many buttons will be shown in the Keypad
button configuration.

The Keypad Node ID and CAN Addresses must match the settings
programmed into the Keypad. The Restore Defaults button will select the
default settings for the particular Keypad.

Keypads are supplied by MoTeC pre-programmed with default settings for
Keypad 1. Keypads can be re-programmed using the Keypad Configuration
tool. See Operation for more detail.

The Brightness Control settings allow the Keypad backlight and LED
brightness to be set to a specified level. An alternate brightness level and
condition can be specified to allow day/night operation.
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Input Pins

Configuration of an input will create a Status and a Voltage channel. Both
channels can be used in a condition or to directly control an output. They are
transmitted via CAN.

To configure an Input Pin

¢ In the Configuration Tree, select Input Pins

e Double click the input to setup

e Type a channel name and select settings as required

The trigger voltages are fully programmable. The recommended trigger
voltages are approximately 3.5 V for the low threshold and 4.2 V for the high
threshold. The high threshold should be set below 6 V to ensure detection of a
high level signal when the battery voltage is low.

To avoid switch bounce and/or to delay recognition when the switch changes
state, the inputs also have programmable trigger times. A trigger time of 0.1
second will normally reject switch bounce.

Channel Name Description CAN Output
InputName Input Status Yes
0 = Off
1=0n
InputName.Voltage Voltage on the input Yes
Resolution 0.2 V

CAN Inputs

The PDM can receive CAN messages allowing the outputs to be controlled by
other devices.

The PDM can be configured to receive CAN messages on up to seven
different CAN addresses in the standard or extended address ranges. The
CAN addresses and message timeout periods are configured in Global Setup
in the Configuration Tree.

To configure a CAN input

¢ In the Configuration Tree, select CAN Inputs

e On the Edit menu, click Add

e Type a channel name and select settings as required
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Channel extraction

Channels are extracted from the CAN messages by specifying the CAN
message and a byte offset within the message. Optional bit masking, byte
swapping and dividing operations can be performed on the received channel,
depending on the data size (8bit, 16bit signed or 16bit unsigned).

8 Bit Values

An 8bit value is specified with a byte offset and an 8bit mask. To use the
entire 8bit value, set the mask to FF (hex).

16 Bit Signed Values

A 16bit signed value is specified with a byte offset (the first byte of the
value within the CAN message), an optional byte swap, and a divisor (1 to
255). The resulting channel will be an 8 bit value with a range of 0 to 255.

The PDM treats the received value as a signed 16 bit value (i.e. -32768 to
32767). Negative values are clamped to 0. If the value after division is
greater than 255 then the result value will be clamped to 255.

16 Bit Unsigned Values

A 16bit unsigned value is specified with a byte offset (the first byte of the
value within the CAN message), an optional byte swap, a 16bit mask, and
a divisor (1 to 255). The resulting channel will be an 8 bit value with a
range of 0 to 255.

The PDM treats the received value as an unsigned 16 bit value (i.e. 0 to
65535). If the value after division is greater than 255 then the result value
will be clamped to 255.

Examples of the different types of CAN channel extraction are included in the
Appendices.

Timeout values

If the CAN message is not received for a period exceeding its timeout period,
the corresponding timeout channel will be set to TRUE. Each CAN input
channel can be configured to hold its previous value or go to a specific value
while the corresponding CAN message is timed out.

Tip: The timeout channel can be used in a condition.

Initial values

If the channel is configured to hold the previous value when the CAN
message times out, then the channel will be set to zero on start-up. The
channel stays zero until a matching CAN message is received.
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If the channel is configured to use a specific value when the CAN message
times out, then the channel will be set to this value on start-up. The channel
stay at the timeout value until a matching CAN message is received.

The PDM CAN bitrate is user configurable. All devices on the CAN bus must
be set to the same speed. Refer to the Operation section for details about
CAN bitrate configuration.

CAN Output

The PDM can transmit a set of fixed standard messages, and up to four user
defined messages on the CAN bus. CAN messages are configured in CAN
Outputs in the Configuration Tree.

The receiving device can use the messages for diagnostic purposes
(particularly useful if the values are logged in a logging device), to show an
alarm on a display, or to activate a feature in another device depending on the
value of a PDM input switch.

CAN Outputs Transmit can be used to control when outgoing messages are
transmitted. This affects all CAN messages, including those used by CAN
Keypads. CAN Outputs Transmit is configured under Global Setup.

The PDM CAN bitrate is user configurable. All devices on the CAN bus must
be set to the same speed. Refer to the Operation section for details about
CAN bitrate configuration.

Standard Messages

The fixed message sets that are sent from the PDM are configured in
Standard Messages. Message sets can be individually enabled, and a base
CAN address is user configurable in the standard or extended address
ranges.

Most MoTeC logging devices have CAN communications templates available
to receive these messages.

The transmitted CAN messages include Output Voltage, Output Current,
Output Load, Output Status, Input State, Internal Temperature, Battery
Voltage, Global Error, and Total Current. See CAN Output Messages in the
Appendices for details on the CAN messages.

Standard messages are transmitted at 20Hz by default. Lower transmission
rates can be selected.

User Defined Messages

Up to four user defined CAN messages to be sent from the PDM can be
configured in Message 0 to Message 3.

Up to 8 channels can be included in each CAN message, with one channel
per message byte.
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The CAN address is user configurable in the standard or extended address
ranges.

User defined messages are transmitted at 50Hz by default. Lower
transmission rates can be selected.

Functions

Conditions

A condition is a complex logic function that combines several channels to
create a new channel. The logic operations include AND, OR, flash and many
more.

The new channel, with a value of either TRUE (1) or FALSE (0), can be used
to directly control an output or it can be used in another condition.

Counters

A counter generates an integer channel value that can be incremented or
decremented on transitions of other logic channels.

Number of Operations

There are a total of 200 logic operations available in the PDM. The number of
operations used is shown in the status line.

Tip: A condition can also be configured in the output pin setup. In this case
the outcome of the logic function will not create a new channel but will be
directly connected to the output channel.

To configure a Condition or Counter

¢ Inthe Configuration Tree, select Functions

e On the Edit menu, click Add

e Select the function type (Counter or Condition)

e Type a channel name and select settings as required

Output Pins

All outputs are high side type outputs; they switch Batt+ to the output pin. All
outputs have hardware thermal overload protection, fault logic and over-
current logic.

Paralleled Outputs

When two or more output pins are connected in parallel, they must be
configured to use a common channel or an identical condition to activate
them.
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Note: outputs that are connected in parallel must all be of the same type;
either all 8 Amp or all 20 Amp outputs.

Output Protection

Over-Current Shutdown

An Over-Current Shutdown occurs when the Output Load exceeds 100%,
which corresponds to the maximum current setting.

The Output Load value is filtered so that it normally increases (and
decreases) slowly, modelling how the temperature of a wire responds to
the current flowing through it. The resultant characteristic is very similar to
a thermal circuit breaker which is often used in motorsport applications. It
is also similar to a slow blow fuse. See Fuse Characteristics for details.

The filtering of the load value ensures that the start-up current (inrush
current) of motors and lamps does not cause the output to shutdown
during this period. It also allows for short term overloads to occur without
the output shutting down.

A large over-current such as a short circuit will cause the Output Load
value to increase rapidly, causing the output to shutdown in a short period
of time to protect the wire and the PDM output. The filtering is set with a
time constant of 20 to 50 seconds based on the maximum current setting.
These values conservatively suit the appropriate wire gauge for the
selected current setting and are not adjustable.

Tips:

e The Output Load and Output Current values are transmitted via CAN so
that they can be logged by another device. Check the logged Output
Load value to ensure it is not too close to 100% during normal
operation and during start-up.

e The Output Load and Output Current values can also be monitored
using PDM Manager. See Checking Operation.

Fault Shutdown

A Fault Shutdown occurs when the output voltage is lower than expected.
This can be caused by a short circuit or thermal overload of the output.

A short circuit may cause a Fault Shutdown before the Over-Current
Shutdown occurs.

Output Settings

To configure an Output Pin
¢ In the Configuration Tree, select Output Pins
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e Double click the output to setup
e Type a channel name and select settings as required

Maximum Current

This sets the current at which the output will shutdown. The output current
may exceed this value for a period of time which allows for the start-up
(inrush) current of devices such as motors and lamps.

The maximum current can be set to 10 ampere on the 8 Amp outputs and
25 ampere on the 20 Amp outputs to be clear of the normal running
current, even for devices that draw the maximum specified current of 8 or
20 ampere.

Number of Retries and Retry Delay

When an Over-Current Shutdown or a Fault Shutdown occurs, the PDM
will attempt to turn the output on again if the Number of Retries is
configured. The Number of Retries determines how many times an output
will attempt to turn on again.

The Retry Delay determines how long an output remains shutdown before
it is turned on again.

The retry count for an output is reset whenever the condition driving the
output changes to FALSE and then to TRUE (i.e. when the condition
driving the output turns off then on again).

Master Shutdown

If Master Shutdown is enabled on the output, the output will be turned off
while the Master Shutdown channel is true.

The Master Shutdown channel is configured in the Global Setup.

Stay Alive During Standby Mode

Up to four outputs can be configured to stay alive (i.e. remain turned on)
during the PDM low power standby mode.

Refer to the
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Standby Mode section for more information.

Linked High Speed Wiper Output (for Output 9 only)

PDM hardware, version 2 onwards, has additional functionality to simplify
windscreen wiper motor control.

Linked output control can be enabled and a linked channel can be selected
in the settings for Output 9.

If this setting is enabled then Output 9 will be held off while the linked
channel used for the high speed wiper winding is turned on.

See the Windscreen Wipers section for more detail.

Tips:

There is a Master Retry feature available in Global Setup.

Ensure that the maximum current has been set appropriately by
checking that the Output Load value is less than 100% under all
operating conditions.

The wire used must be capable of carrying the current specified in the
maximum current setting. See Wire Specification.

Set the maximum current well clear of the normal operating current of
the device but within the current rating of the wire. Use a larger wire to
achieve this if necessary. For example, for a device that draws no more
than 5 ampere (except at start-up) use a wire that is rated at 8 ampere
and set the maximum current to 8 ampere to give a clear margin.

Consider the voltage drop of the wire when selecting the wire size.
Sometimes this dictates that a larger wire gauge is needed than the
current rating would suggest.

Setting the current close to the normal current of the device to try and
protect the device is unlikely to be effective and could result in an
inadvertent shutdown. The purpose of the maximum current setting is
to protect the wire from overheating, not to protect the connected
device.

Some devices draw more current under circumstances such as high or
low battery voltage. Also, a motor will draw increased current when
under more load. Set a good margin and where possible check the
Output Load value under these varying circumstances.

Configuration of an output will create a number of channels, some of which
are transmitted via CAN. OutputName.Status channel is used for output
status information on CAN. The output should be on for any non-zero value.
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Channel Name Description CAN
Output
OutputName Output Control Status No
0 = Off
1 = On (Note: the output may be off
due to Over-current Shutdown or
Fault Shutdown)
OutputName.Voltage | Voltage on the output Yes
Resolution 0.2 V
OutputName.Current | Output Current in amps Yes
Resolution 0.5 A on Outputs 1 — 8
Resolution 0.2 A on Outputs 9 — 32
OutputName.Load Output Load. Filtered current as a Yes
percentage of the maximum current
setting.
Resolution 1%
OutputName.Status 0 = Off Yes
1 =0n Active
2 = QOver-Current Shutdown
4 = Fault Shutdown
OutputName.Status. | 0 = Output is off No
Active 1 = Output is on
OutputName.Status. | 0 =OK No
OverCurrent 1 = Over-Current Shutdown
OutputName.Status. | 0 = OK No
Fault 1 = Fault Shutdown

Fault Indicator

When an output fault occurs, the PDM sets the value of the Global Error

channel to TRUE (PDM.Global Error). A fault indicator light can be connected
to any PDM output and configured to turn on when the Global Error channel is
TRUE.

The Global Error channel can also be transmitted via CAN to a display device
and used to show an alarm message and activate an alarm light.

Maximum Current for Typical Output Devices

Lamps

e Tungsten Lamps
Typically used for tail lights, indicator lights and general lighting.
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Tungsten lamps draw additional current during turn on. Typically this
peaks at about 5 times the steady state current and dies out in about 0.1
second. The PDM will largely ignore this due to the Output Load filtering.

e Halogen Lamps

Halogen lamps are commonly used in headlights and are more efficient
than Tungsten lamps.

Halogen lamps have similar characteristics to Tungsten lamps.
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e Xenon (HID) Lamps

Xenon lamps are also used in headlights and are more efficient than
Tungsten and Halogen lamps.

Xenon lamps have a long duration inrush current that peaks at about 4
times the steady state current. The inrush current decays over a period of
about 10 seconds. This puts a high load on the PDM output during start-
up.

To avoid Over-Current Shutdown during start-up it may be necessary to
set a higher Maximum Current than normal particularly if the battery
voltage is low.

For example, a Xenon lamp with a steady state current of 3 ampere may
need a Maximum Current setting of 6 to 8 ampere. The wire should also
be rated at this current.

Unlike other lamps, Xenon lamps draw more current as the battery voltage
decreases. At 10 volt the lamp will draw 40% more current than at 14 volt.
For example a lamp that draws 3 ampere at 14 volt will draw 4.2 ampere at
10 volt. This must be allowed for when setting the Maximum Current.

To ensure that the Maximum Current is set appropriately, check that the
Output Load value stays safely below 100% during turn on when the
battery is at 12 volt (not charging).

Motors

Electric motors draw additional current during start-up. Typically the start-
up current is 3 to 5 times the steady state current and it dies out in less
than a second.

This start-up current is largely ignored by the PDM due to the Output Load
filtering.

The current in a motor increases with increasing load on the motor. A
motor draws maximum current when it is stalled. The Maximum Current
setting should take this into account.

A motor may draw more current as it or the device that it is connected to
ages; this should be allowed for when setting the Maximum Current.

Note: Motor speed control is currently not supported.
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CAN Keypads

Up to four MoTeC CAN Keypads can be configured to work with the PDM. A
Keypad must be enabled and configured under the Global Settings before the
individual buttons can be configured.

To use a Keypad button, a channel name must be specified. This channel will
be true while the Keypad button is pressed.

Each of the three LEDs on a Keypad button can be controlled with a PDM
channel. The LED will be turned on while the channel is true.

A maximum of 120 Keypad LEDs (across all Keypads) can be configured.
Keypad button numbering is from left to right, from top to bottom.

s 3
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1 2 3 4 5

6 7 8 9 || 10

11 )12 || 13 || 14 || 15
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Operation

CAUTION: The PDM may get very hot; do not touch the PDM during
operation.

To perform any of the activities in the Online menu, the PC needs to
communicate with the PDM.

When a configuration file is open in PDM Manager, it will connect to the PDM
with the matching serial number.

If there is no file open, all connected PDMs will be displayed. PDM Manager
can be connected to a selected PDM.

CAN Bus Bitrate

The PDM can be configured to operate at CAN bit rates of 250Kbps, 500Kbps
or 1Mbps.

PDM Manager includes a CAN bitrate conversion tool under Tools > Options >
Communications. This tool configures the CAN bitrate and restarts the PDM at
the new rate.

Note: During the conversion process, all CAN devices must be removed from
the CAN bus except for the PDM and the UTC.

PDM Manager must be configured (via Tools > Options > Communications) to
match the PDM CAN bit rate.

Sending and Retrieving Configuration Files

e On the Online menu, click Send Configuration to send the currently open
configuration file to the connected PDM

¢ On the Online menu, click Get Configuration to retrieve the current
configuration file in the connected PDM

Checking Operation

Monitor Channels
e On the Online menu, click Monitor Channels

Monitor Channels shows the value of each channel in the original tree
structure.
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Monitor PDM

e On the Online menu, click Monitor PDM

Monitor PDM shows the input-, output-, CAN input-, condition- and PDM status
channels in separate screen areas in an easy to view layout.

Test Outputs
e On the Online menu, click Test Outputs

All outputs may be manually turned on and off in PDM Manager to check the
current levels.

To be able to test an output, it must first be configured in PDM Manager.

Serial Number

e On the Online menu, click Show Serial Number

A configuration file can only be sent to the PDM with the matching serial
number.

This allows multiple PDMs to be used without special device configuration
requirements and also ensures that each PDM has the correct configuration
file.

Firmware Versions and Updating

e On the Online menu, click Update Firmware

The software inside the PDM (firmware) can be updated by the user at any
time to take advantage of the latest features.

Matching Versions

The firmware version must match the version of the PDM Manager software on
the PC in order to communicate. PDM Manager will show a warning if the
versions do not match.
Tip:
To check the version of PDM Manager software, click About MoTeC PDM
Manager on the Help menu.
To check the firmware version in the PDM click Show Serial Number on the
Online menu

Matching Configuration File

Configuration files created with new software including new features cannot
be used with older version of the software. If required, create backup files
before updating.
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Password Protection

e On the Online menu, click Set Password

The password will prevent unauthorised retrieving and sending of configuration
files.

It is not possible to update firmware if the PDM is password protected.

Automatic Send Configuration

This feature is intended to assist users that wish to load an identical
configuration into multiple PDMs (of the same type).

Automatic Send Configuration can be run from Tools > Options >
Communications once a configuration file has been opened.

Multiple PDMs can be simultaneously connected to the CAN bus. The tool will
automatically send the loaded configuration file to each PDM. Once updated,
PDMs can be disconnected. Additional PDMs can also be connected at any
stage.

Note:

e The serial number set in the configuration file is ignored; it will be set
during the send process to the serial number of the PDM.

e When retrieving a configuration file from the PDM, it may not match the
file on disk due to the change in serial number.

Keypad Configuration

CAN Keypads are supplied by MoTeC pre-configured with the default settings
for Keypad 1 on a 1Mbps CAN bus. This configuration is suitable for most
applications.

The Keypad settings may need to be reconfigured for the following situations:
e Multiple Keypads are used on the same CAN bus

e Alternate CAN addresses are required to avoid device conflicts on the
CAN bus

e The CAN bus bitrate is 500Kbps or 250Kbps

PDM Manager includes a Keypad Configuration tool in the Tools > Keypad
Configuration menu. This tool can reprogram a Keypad to change the CAN
addresses and CAN bitrate.

During the Keypad configuration process, only the Keypad and UTC should be
connected to the CAN bus. All other CAN devices (including the PDM) should
be turned off to allow the CAN bus speed to be changed during the
reconfiguration process.
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The existing Keypad CAN bus speed must be specified by the user during the
configuration process so that the Keypad can be found. If the CAN bus speed
is not known then the configuration can be attempted at different speeds until
the Keypad is successfully found.

It is recommended that the default Keypad settings (Keypads 1 to 4) are used
whenever possible. These settings match the default settings for Keypads in
the configuration.
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Standby Mode

The PDM has a low power standby mode to minimise battery drain when the
vehicle is turned off.

Up to four outputs can be configured in the Output Pin settings to stay alive
(i.e. remain turned on) during the standby mode. These outputs are intended
for powering applications where electronic devices require a continuous low
current (typically micro amps) supply to maintain settings or state.

The PDM enters the low current Standby Mode when all of the following
conditions have been true for 5 seconds:

- All outputs that do not have the “stay alive during standby mode” option
enabled are turned off

- All outputs that have the “stay alive during standby mode” option enabled
are below the allowed current limits (approximately 0.5A)

- No CAN messages have been received

- No CAN messages have been successfully transmitted.
There are two ways to ensure this condition is met:

1 the PDM powers off all other devices on the CAN bus when Standby
Mode is required.
Note: This is only possible when the PDM controls power to all devices
on the CAN bus.

2 CAN Outputs Transmit is False to stop all PDM transmissions. See
also CAN Outputs Transmit
This option is used when the PDM can’t control power to all devices on
the CAN bus, for example, when the application has two PDMs on the
same CAN bus or an alarm or remote-entry unit on the CAN bus must
remain powered.

The PDM will exit the Standby Mode when any of the following conditions are
true:

- Activity is present on the CAN bus

- Any output that has the “stay alive during standby mode” option enabled
exceeds the allowed current limit (approximately 0.5A)

- Any input pin changes state
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Specifications
General
Battery voltage 30 V max, 6.5V min
Current consumption 35 mA typical operating
5 mA typical standby
Total output current PDM16 PDM32 PDM15 PDM30
(continuous) 100 A 120 A 80 A 100 A

Reverse battery
protection

Protection for PDM and all connected devices

Load dump transient
protection

Protection for PDM.
Also assists in protecting connected devices.

Operating temperature

110 °C max internal (100 °C recommended)
Typical 85 °C max ambient for 120 A total load (for
110 °C internal) depending on mounting, air
circulation and load distribution.

These specifications apply for a 12 V battery.
For a 24 V battery reduce specified temperatures

coating on PCB

by 20 °C.
Weight PDM16 PDM32 PDM15 PDM30
330¢g 405 g 260 g 270 g
(0.72 Ibs) | (0.89 Ibs) (0.57 Ibs) | (0.59 Ibs)
Length 130 mm 180 mm 107 mm 107 mm
(5.1 (7.1 4.2") 4.2M
Width 60 mm 60 mm 133 mm 133 mm
(2.4" (2.4" (5.2" (5.2"
Height 28 mm 28 mm 39 mm 39 mm
(2.1 1.1 (1.5" (1.5
Case Machined aluminium Magnesium
Environmental Rubber seal on lid and Conformal coating on
protection connectors, conformal PCB
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20 Amp Outputs

Number of 20 A outputs

PDM16

PDM32

PDM15

PDM30

8

8

8

8

Maximum output current

20 A continuous, 115 A transient (typical)

Over-current shutdown

Programmable in steps of 1 A

Protection

Short circuit and thermal overload
protection

Inductive load clamp voltage

—17 V (relative to Batt-)

Maximum inductive load
energy

1.5 J (junction temperature = 150 °C, load
current = 20 A)

8 Amp Outputs

Number of 8 A outputs

pPDM16 | PDM32 | PDM15 | PDM30

8 24 7 22

Maximum output current

8 A continuous, 60 A transient (typical)

Over-current shutdown

Programmable in steps of 1 A

Protection

Short circuit and thermal overload
protection

Inductive load clamp voltage

Output 9: =0.7 V (relative to Batt-)
Other Outputs: =42 V (relative to Batt+)

Maximum inductive load
energy

0.3 J (junction temperature = 150 °C, load
current = 20 A)

Inputs

Number of inputs

PDM16 | PDM32 | PDM15 | PDM30

12 23 16 16

Pull-up resistor

10 kilo ohm to Batt+

Measurement Range of 0 to 51 V, resolution 0.2 V
(8 bits)
Calibration High and low trigger voltage, high and low
trigger times
CAN Input

| Number of messages

4 messages, 8 bytes per message

CAN Output

Message rate

User configurable. 20Hz max (Standard) or
50Hz (User Defined Messages).
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CAN Input Channel Examples

Sample received CAN message used in examples below

Byte 0 1 2 3 4 5 6 7
Value (hex) 00 | 00 | F3 | 21 | 40 | 00 | CC | BA
Channel Extraction Examples

Offset Data Size Mask

Byte 2 8bit FF

Resulting channel: 0xF3 masked with OXFF = OxF3

Offset

Data Size

Mask

Byte 2

8bit

02

Resulting channel: 0xF3 masked with 0x02 = 0x02

Offset Data Size Alignment | Divisor

Byte 3 16bit (signed) Normal 100
Resulting channel: 0x2140 / 100 = 85

Offset Data Size Alighment | Divisor

Byte 3 16bit (signed) Swap Bytes | 100
Resulting channel: 0x4021 / 100 = 164

Offset Data Size Alignment | Divisor

Byte 2 16bit (signed) Normal 100

Resulting channel: 0xF321 is negative (-3295)

so channel is clamped to O

Offset Data Size Alignment | Mask Divisor
Byte 6 16bit (unsigned) | Swap Bytes | OFFF 25
Resulting channel: (Ox8ACC masked with OXOFFF) / 25 = 110
Offset Data Size Alighment | Mask Divisor
Byte 6 16bit (unsigned) | Normal FFFF | 100

Resulting channel: (OXCC8A masked with O0xOFFF) / 100 = 523 so channel is
clamped to 255

37
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Typical CAN Input Channel Application

A CAN message contains a 16 bit RPM value with resolution of 1 RPM.
Using a 16bit unsigned data type and a divider of 100 gives a resulting
channel with a resolution of 100 RPM. The maximum channel value of 255
will be equivalent to 25500 RPM.

The resulting channel can be used in conditions to turn outputs on when the
RPM is above or below pre-set limits.
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Fuse Characteristics

100.00

Trip time
(s)

10.00

1.00

0.10

Trip time versus over current multiplier at 10A

T

5 6 7

Over current multiplier

10

Max current setting [A]

Trip time multiplier

4 76%
6 84%
8 92%

10 100%

15 120%

20 140%

Example:

For 25 A current where max current setting is 5 A:
Over current multiplier: 25 A/5A =5

From Graph: Trip time (at 10 A) is approx. 1 second
From Table: Trip time multiplier (at 5 A) is approx. 80%

Trip time (at 5 A) = 1 x 80% = 0.8 seconds
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Connectors and Pinout

PDM16
Connector A Connector B
26 pin Autosport 1 pin Autosport
Mating connector #65040 Mating connector:
#68093 (wire gauge #6 AWG)
#68094 (wire gauge #4 AWG)
Pin Function Pin Function
A A 8 A Output 9 B 1 Batt+

A_B 8 A Output 10
A_C 8 A Output 11

A D Digital/Switch Input 1 Connector C

AE Digital/Switch Input 2 8 Pin Autosport

AF Digital/Switch Input 3 Mating connector #68092
AG [0V Pin Function

A H oV C_A 20 A Output 1
AJ CAN Low C B 20 A Output 2
A_K CAN High c_C 20 A Output 3
AL 8 A Output 12 C_D 20 A Output 4
A M 8 A Output 13 C_E 20 A Output 5
A_N 8 A Output 14 C_F 20 A Output 6
A_P 8 A Output 15 C_G 20 A Output 7
A_R 8 A Output 16 CH 20 A Output 8

A_S Digital/Switch Input 4
AT Digital/Switch Input 5
A_U Digital/Switch Input 6
A_V Digital/Switch Input 7
A_W | Digital/Switch Input 8
A X Digital/Switch Input 9
AY Digital/Switch Input 10
A Z Digital/Switch Input 11
A_a Digital/Switch Input 12
A b Batt—

Ac Batt—
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PDM32

Connector A

Connector B

37 pin Autosport
Mating connector #68089

26 pin Autosport

Mating connector #65040

Pin Function Pin Function
Al Digital/Switch Input 1 B_A 8 A Output 9
A2 Digital/Switch Input 2 B B 8 A Output 10
A_3 Digital/Switch Input 3 B_C 8 A Output 11
A_4 Digital/Switch Input 4 B_D 8 A Output 12
A5 Digital/Switch Input 5 B_E 8 A Output 13
A 6 oV B F 8 A Output 14
A7 ov B G 8 A Output 15
A 8 ov B H 8 A Output 16
A9 oV B_J 8 A QOutput 17
A_10 CAN Low B_K 8 A Output 18
A 11 CAN High B_L 8 A Output 19
A_12 Digital/Switch Input 6 B_M 8 A Output 20
A 13 Digital/Switch Input 7 B_N 8 A Output 21
A 14 Digital/Switch Input 8 B_P 8 A Output 22
A_15 Digital/Switch Input 9 B_R 8 A Output 23
A 16 Digital/Switch Input 10 B_S 8 A Output 24
A_17 Digital/Switch Input 11 B_T 8 A Output 25
A_18 Digital/Switch Input 12 B_U 8 A Output 26
A_19 Digital/Switch Input 13 B_V 8 A Output 27
A_20 Digital/Switch Input 14 B_W | 8 A Output 28
A_21 Digital/Switch Input 15 B_X 8 A Output 29
A 22 oV B_Y 8 A Output 30
A 23 oV B 7 8 A Output 31
A 24 oV B_a 8 A Output 32
A_25 oV B_b Batt—

A_26 Digital/Switch Input 16 B_c Batt—

A_27 Digital/Switch Input 17

A 28 Digital/Switch Input 18

A_29 Digital/Switch Input 19

A_30 Digital/Switch Input 20

A 31 Digital/Switch Input 21

A_32 Digital/Switch Input 22

A_33 Digital/Switch Input 23

A_34 Not Connected

A 35 Not Connected

A 36 Not Connected

A_37 Not Connected
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PDM32 continued

Connector C

1 pin Autosport

Mating connector
#68093 (wire gauge #6 AWG)
#68094 (wire gauge #4 AWG)

Pin

Function

C.1

Batt+

Connector D

8 pin Autosport
Mating connector #68092

Pin

Function

)
>

20 A Output 1

20 A Output 2

20 A Output 3

20 A Output 4

20 A Output 5

20 A Output 6

20 A Output 7

DDUUUUUl
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20 A Output 8
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PDM15

Connector A

Connector B

34 pin waterproof connector
Mating connector #65044

26 pin waterproof connector
Mating connector #65045

Digital/Switch Input 1

ov

Digital/Switch Input 3

Digital/Switch Input 5

Connector C

Pin Function Pin Function

A1l 20 A Output 1 (with A10) B 1 Not used

A2 8 A Output 9 B 2 Not used

A 3 20 A Output 2 (with A12) B 3 20 A Output 6 (with B9)
A4 8 A Output 10 B 4 Not used

A5 20 A Output 3 (with A14) B 5 20 A Output 7 (with B11)
A_6 8 A Output 11 B_6 Not used

A7 20 A Output 4 (with A16) B_7 20 A Output 8 (with B13)
A 8 8 A Output 12 B 8 Not used

A9 20 A Output 5 (with A17) B 9 20 A Output 6 (with B3)
A 10 20 A Output 1 (with A1) B_10 Not used

A 11 8 A Output 13 B_11 20 A Output 7 (with B5)
A 12 20 A Output 2 (with A3) B_12 Not used

A 13 8 A Output 14 B 13 20 A Output 8 (with B7)
A 14 20 A Output 3 (with A5) B 14 Not used

A 15 8 A Qutput 15 B_15 Digital/Switch Input 13
A_16 20 A Output 4 (with A7) B_16 Not used

A_17 20 A Output 5 (with A9) B_17 Digital/Switch Input 15
A 18 Not used B_18 Battery Negative

A 19 Digital/Switch Input 2 B 19 Not used

A_20 Not used B_20 Digital/Switch Input 11
A_21 Digital/Switch Input 4 B 21 Digital/Switch Input 12
A_22 Not used B_22 ov

A 23 Digital/Switch Input 7 B_23 Digital/Switch Input 14
A 24 Not used B 24 Digital/Switch Input 16
A 25 Not used B_25 CAN Low

A _26 Battery Negative B 26 CAN High

A 27

A 28

A 29

A 30

A 31

A 32

A3

A_3

Digital/Switch Input 6 M6 stud

Digital/Switch Input 8 Mating: eyelet and M6 nut
3 Digital/Switch Input 9 Pin Function
4 Digital/Switch Input 10 C1 Battery +
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PDM30

Connector A

Connector B

34 pin waterproof connector
Mating connector #65044

26 pin waterproof connector
Mating connector #65045

Pin Function Pin Function

A1l 20 A Output 1 (with A10) B 1 8 A Output 21
8 A Output 9 B 2 8 A Output 22
20 A Output 2 (with A12) B-3 20 A Output 6 (with B9)
8 A Output 10 B 4 8 A Output 23

20 A Output 3 (with A14)

d
(¢)]

20 A Output 7 (with B11)

8 A Output 11

8 A Output 24

20 A Output 4 (with A16)

20 A Output 8 (with B13)

8 A Output 12

8 A Output 25

20 A Output 5 (with A17)

20 A Output 6 (with B3)

20 A Output 1 (with A1)

8 A Output 26

8 A Output 13

20 A Output 7 (with B5)

20 A Output 2 (with A3)

8 A Output 27

8 A Output 14

20 A Output 8 (with B7)

20 A Output 3 (with A5)

8 A Output 28

8 A Output 15

Digital/Switch Input 13

20 A Output 4 (with A7)

8 A Output 29

20 A Output 5 (with A9)

Digital/Switch Input 15

8 A Output 16

Battery Negative

Digital/Switch Input 2

8 A Output 30

8 A Output 17

Digital/Switch Input 11

Digital/Switch Input 4

Digital/Switch Input 12

8 A Output 18

ov

Digital/Switch Input 7

Digital/Switch Input 14

I>I>I> J>|>|>|>J>J>|>|>|>J>J>|>|>|>J>J>|>|>|>J>
NN (R(R(R(RR[R[R P[RR [o|o[~N[o o[~ [w|N

AIWIN|IRP|OC|O|0|IN|O|OT|D|W|IN|F(O

8 A Output 19

Digital/Switch Input 16

8 A Output 20

CAN Low

Battery Negative

0|00|00|00|00|00|00|00|C0|00(00(C0(C0(00(C0(00|00(00|00|00|0o|00
NN NN (RRIRR(RPR R [R|R[o|o|N|o

OO WINIRP|IC|IO|O|N|O|O|R|W|IN|F|O

CAN High

Digital/Switch Input 1

> > |> >
N[N N[N
o[~ |o o

oV

A_29 Digital/Switch Input 3

A 30 Digital/Switch Input 5 Connector C

A 31 Digital/Switch Input 6 M6 stud

A_32 Digital/Switch Input 8 Mating: eyelet and M6 nut
A 33 Digital/Switch Input 9 Pin Function

A_34 Digital/Switch Input 10 C1 Battery +
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Mounting Dimensions

PDM16
60 13.1 28
0.7 26.5
——|<— |<——
/ 4
® & @ 5
o) . B
N : dc) -
~5@i
D L L0 w
&b @®
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/‘) .
< L
© 3
~50a
< g
(321 Q
= ® c
g } ~st
@D 1 @ <o &
\UZ
[e]
/_)
<
(32}
@ K

@5.2 Hole (2x)
To suit M5 or 3/16"
> ! Max. Washer or Head ©10.6
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PDM32

28

26.5

uid 8
Jojpauuo)d

(a)

ud |
Jojoauuo)d

(0)

A

uid 9¢
Jojosuuo)

(@

A

uid /g
Jojosuuo)

(v)

13.1

e\

\

60

0.7

a
N2

SR

\G

ye

12

€€

08l

@5.2 Hole (2x)
To suit M5 or 3/16"
Max. Washer or Head @10.6
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PDM15 and PDM30

Cover power stud with
insulating cap

R5.5 107.5 15.5
} 4 Power
(¢ - ) Connectio -~
5.2 Hole (3x)
To suit M5 or 3/16"
Max. Washer or Head @13
© | \
~ i - |
0 @ 3 Z
N~ —
S s |, 9;.5 , 17.9
AN l ______ it {___%
\ I K ™ _
<
| N~
[ i -
< | <
[ I ] J
\_ I ) N ___
| o L o | <1
67.5 18°
3 , 239 92
0 38.7

Connector
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Wiring

Wire Specification

M22759/16

Insulation Material: Tefzel
Conductor: Tin Plated Copper
Voltage Rating: 600 V
Maximum Temperature: 150 °C

Wire |Current Rating |Current Rating Resistance | Resistance

Gauge |at 80 °C ambient |at 100 °C ambient |[ohm/m] [ohm/1000 ft]

(AWG) | [A] [A]*
24# 4.5 4 0.071 22
22# 6 5 0.045 14
20# 8 6 0.028 8.5
18# 11 9 0.018 55
16# 15 12 0.014 4.3
14# 22 18 0.009 2.7
6# 90% 75% 0.0015 0.44
4# 120% 100% 0.0009 0.28
2% 150+ 120+ 0.0006 0.18

*The current ratings above are an indication only and will not apply in all

circumstances.

The actual maximum current rating is determined by the maximum allowed
temperature for the wire (150 °C).

The temperature of the wire is affected by many factors including the
temperature of adjacent wires, how the wires are bundled and covered, the
ambient temperature and the current.

Fcurrent rating for a single wire in free air

Recommended Wire Gauge

Output

244 to 20# 8 Amp outputs
20# to 16# 20 Amp outputs
4# to 2# Battery pos
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UTC Wiring for PC Connection

To connect to a PDM through a MoTeC UTC (USB to CAN adaptor), a mating
connector for the UTC must be wired to the PDM's CAN bus.

The UTC connects to the PC USB port with a standard USB A-B cable.

If the PDM does not connect to any other CAN device, it can be directly wired
to the CAN connector.

If the wiring length is less than 2 m (7 ft) the terminating resistor is
recommended but not essential as the UTC has a built in terminating resistor.

CAN Connector (5 pin XLR Female) PDM
1 Black 9
5 ov
3
4 Green Green 10 CAN-LO
5 White CAN-HI
These wires must be twisted

Minimum one twist per 50 mm (2 in)

100R Resistor
*Not essential if the wiring
length is less than 2 m (7 ft)

UTC Connector Type (5 pin XLR Female):
Deltron ~ 716-0-0501 (Non-latching)
Neutrik NC5FDL1 (Latching)

CAN Bus Wiring Requirements

The CAN bus should consist of a twisted pair trunk with 100R (0.25 watt)
terminating resistors at each end of the trunk.

The preferred cable for the trunk is 100R data cable but twisted 22# Tefzel is
usually OK.

The maximum length of the bus is 16 m (50 ft)

CAN devices (such as MoTeC PDM, M800 etc) may be connected to the
trunk with up to 500 mm (20 in) of twisted wire.

The CAN Connector for the UTC may also be connected to the trunk with up
to 500 mm (20in) of twisted wire and should be within 500 mm of one end of
the trunk. If desired two CAN connectors may be used so that the UTC may
be connected to either side of the vehicle. Both connectors must be within 500
mm of each end of the trunk.
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100R Terminating
Resistors at each

A

uTC
Connector
These wires must be twisted
end of the CAN Bus Minimum one twist per 50 mm (2 in) o] =
500,\r/1|ﬁm T 3
ax
<< CAN Bus >> EE
-
o
o
;|

100R

CAN-HI

CAN Device
eg ADL3

Short CAN Bus

CAN Device
eg M1 ECU

CAN Device
eg PDM

If the CAN Bus is less than 2 m (7 ft) long then a single termination resistor
may be used. The resistor should be placed at the opposite end of the CAN

bus to the CAN connector.
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CAN Output Messages

The PDM transmits the following messages at a configurable rate up to 20 Hz.
Note: Only relevant messages are transmitted for a particular PDM type.

CAN Address |Byte |Bit Channel | Scaling
0 4.7 |CompoundId=0
0 0 Input 1 State
1 0 Input 2 State
2 0 Input 3 State
f%se address 53— Input 4 State 0 = Inactive
4 0 Input 5 State 1 = Active
5 0 Input 6 State
6 0 Input 7 State
7 0 Input 8 State
0 4.7 |Compoundid=1
0 0 Input 9 State
1 0 Input 10 State
2 0 Input 11 State
?%Se address 3 0 Input 12 State 0= Ina_ctive
4 0 Input 13 State 1 = Active
5 0 Input 14 State
6 0 Input 15 State
7 0 Input 16 State
0 4.7 |CompoundIld =2
0 0 Input 17 State
1 0 Input 18 State
Base address |2 0 Input 19 State 0 = Inactive
+0 3 0 Input 20 State 1 = Active
4 0 Input 21 State
5 0 Input 22 State
6 0 Input 23 State
0 4.7 |CompoundId =3
PDM Internal 0to125=0°C to +125°C
1 0..7 o
Temperature 1 °C steps
5 0.7 PDM Battery 0to255=0Vto31V
" Voltage 0.1216 V steps
0=0K
3 0..7 |Global Error Flag 1 = one or more outputs is in
Base address .
+0 either Fault or Over-Current error
4 0..7 |Total Current 010255 =010255A
1 A steps
0to255=0Vto15.68V
5 0.7 9.5V internal rail 0.0615 V steps
" voltage Should read close to 9.5 V when
the Battery voltage is > 10.5 V
6 0..7 |Reset Source
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Base address
+0

0 4.7 |CompoundIld=4

4 0..7 |Output Fault 25..32

5 0..7 |Output Fault 17..24 |0 = No Fault
6 0.7 |Output Fault9..16 |1 =Fault

7 0..7 |Output Fault 1..8
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CAN Address

Byte

@

Channel

|Scaling

Base address
+1

Compound Id =0

Output 1 Current

Output 2 Current

Output 3 Current

Output 4 Current

0to255=0t0127.5 A

Output 5 Current

0.5 A steps

Output 6 Current

Output 7 Current

Base address
+1

Compound Id =1

Output 8 Current

0to255=0t0127.5 A
0.5 A steps

Output 9 Current

Output 10 Current

Output 11 Current

O0to255=0to 51 A

Output 12 Current

0.2 A steps

Output 13 Current

Output 14 Current

Base address
+1

Compound Id =2

Output 15 Current

Output 16 Current

Output 17 Current

Output 18 Current

O0to255=0to 51 A

Output 19 Current

0.2 A steps

Output 20 Current

Output 21 Current

Base address
+1

Compound Id = 3

Output 22 Current

Output 23 Current

Output 24 Current

Output 25 Current

0to255=0to51 A

Output 26 Current

0.2 A steps

Output 27 Current

Output 28 Current

Base address
+1

Compound Id = 4

Output 29 Current

Output 30 Current

Oto255=0to 51 A

Output 31 Current

0.2 A steps

BIWIN|IFPOINO|O[R|WIN|FP[(O|IN(O|O[R|WIN|IFPO|IN(O|ORIWIN| P |ON|O|O|RMWIN|F|O

olololo]ololo|ole]ololo|e|o]ololole|e]olo|ele]olelole] o [o]olelo|e|e]olo]e
Y Y 0 0 Y Y 0 0 Y 0 0 0 Y 0 0 O Y ) 0 Y Y 0 Y Y Y ) Y Y Y

Output 32 Current
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CAN Address

Byte

@

Channel

Scaling

Base address
+2

Compound Id =0

Qutput 1 Load

Qutput 2 Load

Qutput 3 Load

Qutput 4 Load

Output 5 Load

Output 6 Load

Output 7 Load

0 to 255 =0 to 255%
1% steps

Base address
+ 2

Compound Id =1

Qutput 8 Load

Qutput 9 Load

Output 10 Load

Output 11 Load

Output 12 Load

Output 13 Load

Output 14 Load

0 to 255 =0 to 255%
1% steps

Base address
+ 2

Compound Id = 2

Output 15 Load

Output 16 Load

Output 17 Load

Output 18 Load

Output 19 Load

QOutput 20 Load

Output 21 Load

0 to 255 = 0 to 255%
1% steps

Base address
+ 2

Compound Id = 3

Output 22 Load

Output 23 Load

Output 24 Load

Output 25 Load

Qutput 26 Load

Qutput 27 Load

Output 28 Load

0 to 255 = 0 to 255%
1% steps

Base address
+ 2

Compound Id = 4

Output 29 Load

Output 30 Load

Output 31 Load

AIWIN|IFP(OINO|ORWINIFPIOIN|O|U[RWINIFPIONO|OAWINIFPIONOO|AW|N|F|O

e S I I e S e S B B B S el e S I e B S e e S B B e S S e B B S S e S S e
EN] EN] EN3 ENY ENY EN] ENT BN ENT ENE EN] EN] ENT EN] ENT EN3 ENE EN] EN] EN] BN BT ENY EN] EN] ENT ENT ENTENE EN] ENTEN] EN] ENT ENIENT BN

Output 32 Load

0 to 255 =0 to 255%
1% steps
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CAN Address

Byte

@

Channel

‘Scaling

Base address
+3

Compound Id =0

Output 1 Voltage

Output 2 Voltage

Output 3 Voltage

Output 4 Voltage

Output 5 Voltage

Output 6 Voltage

Output 7 Voltage

0to255=0to 51V
0.2 V steps

Base address
+3

Compound Id =1

Output 8 Voltage

Output 9 Voltage

Output 10 Voltage

Output 11 Voltage

Output 12 Voltage

Output 13 Voltage

Output 14 Voltage

Oto255=0to 51V
0.2 V steps

Base address
+3

Compound Id = 2

Output 15 Voltage

Output 16 Voltage

Output 17 Voltage

Output 18 Voltage

Output 19 Voltage

Output 20 Voltage

Output 21 Voltage

Oto255=0to 51V
0.2 V steps

Base address
+3

Compound Id = 3

Output 22 Voltage

Output 23 Voltage

Output 24 Voltage

Output 25 Voltage

Qutput 26 Voltage

Qutput 27 Voltage

Output 28 Voltage

Oto255=0to 51V
0.2 V steps

Base address
+3

Compound Id = 4

Output 29 Voltage

Output 30 Voltage

Output 31 Voltage

AIWIN|IFP(OINO|ORWINIFPIOIN|O|U[RWINIFPIONO|OAWINIFPIONOO|AW|N|F|O

e S I I e S e S B B B S el e S I e B S e e S B B e S S e B B S S e S S e
EN] EN] EN3 ENY ENY EN] ENT BN ENT ENE EN] EN] ENT EN] ENT EN3 ENE EN] EN] EN] BN BT ENY EN] EN] ENT ENT ENTENE EN] ENTEN] EN] ENT ENIENT BN

Output 32 Voltage

Oto255=0to 51V
0.2 V steps
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CAN Address |Byte |Bit Channel Scaling
Compound Id =0
Output 1 Status
Output 2 Status | g = Qutput off
Output 3 Status | 1 = Output on

Base address
+4

Output 4 Status

Output 5 Status

Output 6 Status

Output 7 Status

Output 8 Status

2 = Qutput Fault Error

4 = QOutput Over-Current Error
8 = Output reached maximum
number of retries

Base address
+4

Compound Id =1

Output 9 Status

Output 10 Status

Output 11 Status

Output 12 Status

Output 13 Status

Output 14 Status

Output 15 Status

Output 16 Status

0 = Output off

1 = Output on

2 = Qutput Fault Error

4 = Output Over-Current Error
8 = Output reached maximum
number of retries

Base address
+4

Compound Id =2

Output 17 Status

Output 18 Status

Output 19 Status

Output 20 Status

Output 21 Status

Output 22 Status

Output 23 Status

Output 24 Status

0 = Output off

1 = Output on

2 = Output Fault Error

4 = Output Over-Current Error
8 = Output reached maximum
number of retries

Base address
+4

Compound Id = 3

Output 25 Status

Output 26 Status

Output 27 Status

Output 28 Status

Output 29 Status

Output 30 Status

Output 31 Status

~NOO|RAWINIPIO|IOINO|U|RA|WIN|IFPIOION|O|O|AWIN|P|O|IO|IN|O|U|_|W|IN|IFL|IO|O

SIe|e|e|eee|eIe|eeee|e|e|e|eae|e|e|e|eeee|peeee|If|e|e|e e
NN NN NN N0 NN NN NN NN o NN N NN N NN o NN N NN NN N o N

Output 32 Status

0 = Output off

1 = Output on

2 = Output Fault Error

4 = QOutput Over-Current Error
8 = Output reached maximum
number of retries




MoTeC

Appendices

57

CAN Address

Byte

@

Channel

‘Scaling

Base address
+5

Compound Id =0

Input 1 Voltage

Input 2 Voltage

Input 3 Voltage

Input 4 Voltage

Input 5 Voltage

Input 6 Voltage

Input 7 Voltage

0to255=0to 51V
0.2 V steps

Base address
+5

Compound Id =1

Input 8 Voltage

Input 9 Voltage

Input 10 Voltage

Input 11 Voltage

Input 12 Voltage

Input 13 Voltage

Input 14 Voltage

Oto255=0to 51V
0.2 V steps

Base address
+5

Compound Id = 2

Input 15 Voltage

Input 16 Voltage

Input 17 Voltage

Input 18 Voltage

Input 19 Voltage

Oto255=0to 51V
0.2 V steps

Input 20 Voltage
Input 21 Voltage

5 dd Compound Id =3

+‘?e address Input 22 Voltage |0to 255 = 0to 51 V
Input 23 Voltage |0.2 V steps

Base address
+5

Compound Id = 4

P O] N|RP[OINO|O[R|WIN|FR(O|INO|O|_|WIN|FOINO|O|_|W[N|FO

SRR EEEEEEEERE R EEERE R R EEE R EEERERR
FRCT Y Y 0 0 Y ) Y Y ) Y 0 0 Y ) ) Y Y Y Y 1

Firmware Version
Major

e.g. 19 =version 1.9

Firmware Version

e.g. 1 =version1.91,2 =

2 0.7 Minor version 1.92, etc.
Firmware Version | ASCII value. 65 = A, 66 = B,

3 0.7
Letter etc.

4 0..7 |Reserved

5 0.7 IReserved Not currently used

6 0.7 Serial number The PDM serial number is the

" (High byte) high byte x 256 + low byte.

Serial number e.g. a high byte value of 18 and

7 0.7 u a low byte value of 52 results in
(Low byte)

(18 x 256) + 52 = 4660




